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LICENSE AGREEMENT

© 2011 Airbox Aerospace Limited United Kingdom, all rights reserved.

By installing or using Airbox Software, you indicate your acceptance of the following licensing agree-
ment:

Terms: The word ‘Airbox’ refers to Airbox Aerospace, a limited company registered in the United King-
dom. The term ‘User’ refers to anyone owning or operating an Airbox navigation system. 

Airbox GPS systems are not certified as, nor intended as primary navigation tools. The user agrees not 
to rely on data provided by Airbox and to hold Airbox harmless against any third party claims that might 
arise from any breach of this term by the user. 

Neither Airbox Aerospace Ltd nor any other company connected with the supply of data associated with 
Airbox products accepts any liability for the accuracy of the information provided. Nothing in the sys-
tems supersedes any legislation, rules, regulations or procedures contained in any operational document 
issued by Her Majesty’s Stationary Offices or its affiliates, the Civil Aviation Authority, the Joint Avia-
tion Authority, EASA, ICAO, the manufacturers of aircraft, engines and systems, or by the operators of 
aircraft throughout the world. 

Airbox navigation systems may contain data whose copyright belongs to the following organisations: 
UK Civil Aviation Authority, Ordnance Survey, Jeppesen GmbH, Crecy Publishing Ltd, Pooleys Flight 
Equipment and NATS enroute PLC (NERL)  and there may be additional terms associated with the use 
of their data, which are available on request.

Airbox warrants that all parts of this product shall be free from manufacturing defects for a period of 
one year from the date of first purchase. It is the user’s responsibility to take good care of the product and 
use it in accordance with manufacturers guidelines.

Airbox Aerospace Ltd grants the user a single, non-exclusive, non-transferable license to install and use 
the software on a single computer terminal. The user furthermore agrees to use the software only for 
private, noncommercial use. Commercial licenses are available, but must be purchased separately. No 
part of the software or accompanying literature and packaging may be copied or reproduced without the 
specific written permission of Airbox.

Airbox systems are supplied as portable, not installed, navigation devices. Airbox Aerospace limited ac-
cepts no liability which results in any way, howsoever caused,  from installation or attempted installation 
of these devices into an aircraft.

Your personal information may be collected and stored by Airbox so that we can give you a high level of 
customer service, however no personally identifiable information will be passed to third parties without 
your permission, excepting where required by law.

This agreement is governed by and shall be construed in accordance with the laws of England and Wales 
whose courts shall have exclusive jurisdiction to determine all claims relating to this Agreement.
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1	 Introducing Fastplan

About this manual
We have tried to lay out this manual in a logical way to guide you through processes in the way that we 

think you’re likely to undertake them

You are Important
Thank you for buying our planning software. We have taken great care to make our products easy to use and 
include all of the information that you need. The best advertisement for our product is satisfied customers 
and so,  if after reading this manual and viewing the tutorials on our website, there is anything you don’t un-
derstand, please do call or e-mail our office for help.  For contact information, please see the useful contact 
information section of this manual.

Required Reading
We know that it’s tedious to have to read through a manual before using your new planning software, but it 
is vital to your safety that you understand the points below. 

Airbox Fastplan is a planning aid only. Nothing within the software fulfils any legal requirement placed 1.	
on the pilot.

Airbox is not a substitute for common sense. You should always check the information that you see 2.	
displayed. Some of the information on the system, particularly the terrain data, is indicative only and 
should not be relied on.

It is your responsibility to ensure that the data on the system is up to date. 3.	
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2 The Basics

Installing the software from DVD
When you insert the Airbox DVD into your computer, it will automatically load the installation program 
after a few seconds. Please follow the on-screen instructions. Once the program has installed correctly, 
depending on what you specified, you may have an icon for the program either on your computer desktop 
and/or in the start menu. To load the program, simply double-click one of these icons.

Tip: If you have autorun disabled on your computer, then the disc will not automatically load.  In which case you can 
manually load the software by opening a file explorer window, navigating to the disc and opening setup.exe

Installing the software from a Download
When you click on the download link, you should be given the option to “save or run” the file, please select 
“run”.  Once the file has downloaded, please follow the on-screen instructions. Once the program has 
installed correctly, depending on what you specified, you may have an icon for the program either on your 
computer desktop and/or in the start menu. To load the program, simply double-click one of these icons.

First Run
The first time you run Fastplan, you will need an activation code, this can be obtained from Airbox by tele-
phoning the office during normal working hours or via e-mail.
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The disclaimer screen

Once the software has loaded, you will be presented with the disclaimer screen. You must accept the dis-
claimer before you can use the software.

The Map Screen
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The map screen is laid out with the map in the middle, with information about the map and current posi-
tion at the bottom, and controls at the top. Commonly used functions have an icon above the map and by 
default there will be a sidebar on the left. If you wish, you can make Fastplan full-screen by selecting ‘Full 
Screen’ from the view menu at the top of the page.

Panning and Zooming the map

The map is moved around by holding down the left mouse button over a point on the map and then mov-
ing the mouse in the desired direction. You can also move the map using the cursor keys on your keyboard

Tip: You can use the ‘Find’ box  on the right-hand side of the tool-bar at the top of the screen to jump instantly to 
airfields and other points of interest.

The map is zoomed (or magnified) by rolling the wheel of your mouse forwards and backwards. You can 
also zoom the map in and out using the plus and minus keys on your keyboard.

Tip: The fastest way to move large distances on the map is to zoom out, move the map and then zoom back in.
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The sidebar
On the left of the map, you will see the sidebar, from which useful functions can be accessed quickly. If you 
want to hide the sidebar, you can do so easily using the button immediately below the ‘File’ menu. If an item 
on the sidebar is not showing in full, you can maximise it by pressing on the title of that option.
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3 Planning your first route

Select the right chart series
If you have multiple chart series installed on your Airbox, you can switch to the most appropriate chart 
series for your planned route by clicking on the drop-down menu at the top of the map screen.

Selecting a start and destination
There are two ways to put in a start point and a destination. The first is to select them directly on the map. 
To do this, locate your start point, right-click over it and select ‘append waypoint’, then find your destina-
tion and do the same. 

Tip: If you already have a route defined, you can clear it from the route menu

The other way to input start and destination is to click on the ‘plan new route’ icon in the top left of the 
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screen (or select ‘create new route’ from the File menu). This will then bring up boxes allowing you to put in 
both the start and destination airfields (and VRPs, Navaids etc).

Altering the route to avoid airspace and obstacles
Once you have a basic two point route in the system, you can add new waypoints. To move the route to 
avoid obstacles, all you need to do is hold down the left mouse button over the route and drag it to where 
you want to move it. The software will automatically insert a new waypoint when you do this. Should you 
decide to get rid of a waypoint, you can right-click the mouse on it and select ‘delete waypoint’

IMPORTANT: Airbox will not automatically divert your route to avoid airspace, obstacles, or high ground, this is 
entirely your responsibility.

‘Snap To’ facility
Fastplan will automatically snap your route to airfields, navaids, VRPs and user waypoints if you move it 
near to these points. If you want to turn this feature off, you can do so from the ‘Route’ menu, but please 
note that with this feature switched off, your waypoint list will not show names automatically, and runways 
will not show for new waypoints.

Waypoint lists
In the sidebar at the bottom, your route will be shown, complete with waypoints, distances and bearings. 
You can also bring up a list which you can print by clicking ‘view route’ in the ‘Route’ menu.
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Checking for restricted airspace and high ground

You can check restricted airspace along the route by right clicking on the airspace and selecting ‘airspace 
information’ from the pop-up box.  This will give you all information held on airspace at any height and 
restricted at that point.

You can check the height of the terrain by simply moving your mouse over the map. At the bottom of the 
screen, you will see a height readout for that point. Please note that the height readout display will not 
always agree with spot heights, this is because information held within the system is based on the average 
height for a small area, rather than a point.

Highlighting airspace which is controlled

You can highlight the airspace which is controlled on your route, by selecting ‘Airspace’ from the sidebar. 
The software will show all controlled or potentially hazardous airspace on the map between the altitudes 
you have selected in the sidebar.
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Tip: If you have a lot of airspace turned on, this can slow down your computer. It’s best to ensure that your planned 
flight altitude is set in the sidebar before overlaying the airspace.

Route Profile
You can also bring up a profile of the terrain and airspace on your route by selecting ‘route profile’ from the 
Route menu. When you have the profile on the map, you can get more information on airspace simply by 
moving the mouse over it. You can get further information by left-clicking on it. Please note, that if your 
route is long, your whole route will not be contained on the screen at one time, so you will need to use the 
scroll bar at the bottom of the screen to move along it.

Checking airfield information

You can check information on an airfield by right-clicking on it and selecting ‘airfield information’ from the 
popup menu. If you click on the box marked ‘Runway’ in the sidebar on the left of the screen, Fastplan will 
overlay runways onto the map.
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Tip: You can see from the above picture, that with the weather and runways turned on, you can see the likely runway 
in use. 

Setting the altitude of your flight
You can set the altitude range over which you’re planning to fly. The advantage of doing this is that informa-
tion such as NOTAMs and airspace will then only show if relevant to the flight which you’re planning. You 
can set a lower and upper limit by adjusting the bars in the sidebar on the left-hand side of the screen.

Visualising the route in Google Earth™

Google Earth™ is a powerful tool that allows the user to view the world in 3D with terrain and high-reso-
lution ground photography. The principle advantage for the pilot is that it can give awareness of aerodromes, 
airspace and important points on the route before takeoff.
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Fastplan will transfer theroute complete with controlled airspace relevant to that route into Google Earth. 
You can then select from the Google Earth sidebar the different classes of airspace that you wish to see.

TIP: You may find it useful to look at airfields you’re planning to visit in Google Earth, to give yourself awareness of 
what the approach will look like.

TIP: If you don’t already have Google Earth, you can download it from http://earth.google.com
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4 Synchronising with your Airbox

Synchronising data with your Airbox™ navigation system

Once you’ve finished your route, you should save it using the file menu. Now you can synchronise with your 
Airbox navigation system, which will transfer the route across and syncronise other data at the same time. 
To do this, click on the synchronise icon either at the top of the map screen, or on the welcome screen.

You now need to select the source of your synchronisation. If you have your Airbox navigation system 
plugged into the computer with a USB cable, then you need to select ‘Activesync’, if you have the memory 
card from your Airbox plugged directly into your computer, then you need to select the correct drive for it 
(Airbox strongly recommend using an SD card reader). So long as everything is plugged in correctly, how-
ever, Fastplan should automatically select the correct option. 

Once done, click ‘Update’. If the synchronisation fails, please check carefully that you have the right drive 
selected and that the computer itself has acknowledged that the device or memory card is connected.

IMPORTANT! If you notice strange behavior in your Airbox device after synchronising it with Fastplan, the first thing 
to do is to retry the syncrhonisation. Airbox are available to give you technical support, but most problems of this 
type are caused by a failed synchronisation, or the synchronisation process being interrupted.

IMPORTANT! Users of the Aware navigation system will only be able to transfer routes and not other data
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Troubleshooting synchronisation
IMPORTANT!  Airbox highly recommend the use of SD card readers to perform synchronisation, rather than USB 
cables, this will ensure faster, trouble free synchronisation with your Airbox device

Only the Clarity and the Aware can be connected to the computer via a USB cable. If you have a Fore-
sight skip to paragraph 3. Windows should acknowledge your device is connected even when FastPlan is 
not running. All the drivers required for the unit are contained on the unit itself so it should automatically 
install when first plugged in. You should just see a popup message telling you that windows is installing 
new hardware. When the device is installed it will be detected by Microsoft ActiveSync (Windows XP) or 
Windows Mobile Device Centre (Windows Vista and later). You will need to install Activesync or Mobile 
Device Centre if you don’t have them already; either can be downloaded from Microsoft and can be easily 
found with a Google search. Only when Windows itself has acknowledged the device will FastPlan be able 
to see it.

A small number of computers don’t seem to be able to create/keep a connection to the device using Micro-
soft ActiveSync/Windows Mobile Device Centre. There are a number of simple solutions to this problem:

* Try using a different USB port.

* Press the small reset button on the device with the stylus and try to connect again (reset is to be found on 
the bottom of the clarity or above the SD card slot on the Aware).

* Wait for the device to load the disclaimer page before re-connecting the USB cable.

* Restart your computer after connecting the device for the first time.

* Sometimes other USB devices can interfere with the connection, remove all non-essential USB connec-
tions and ensure that your Airbox device is connected to a USB port in the computer (as opposed to in a 
hub).

All of our devices have an SD Card which can also be used for the sync. If you have a Foresight you will 
have received a USB SD Card reader with your unit but most modern computers have SD Card readers 
already. To synchronise the device via SD card reader:

* With the device turned off remove the SD Card by pressing it in and then releasing it. 

* Put the SD Card into your computer (via the SD Card Reader). 

* Windows will acknowledge you inserting the card and it will appear as an extra drive in My Computer. 

* Start FastPlan, select Sync Airbox and follow the on screen instructions. 

* When the update is successfully completed reinsert the card into the device and turn it back on.
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5 NOTAMs, Weather, flight guides and 
subscriptions

We are trying to make your life easier
We are working hard to make the Airbox system cater to your needs and provide you with the data that you 
need, when you need it. We have therefore made it possible to subscribe to important information including 
NOTAMs, weather and charts.

NOTAMs (requires subscription)

Airbox provides a live NOTAM service, to allow you to be absolutely up to date with the latest notices.  
NOTAMS are displayed on the map as red shaded areas. To turn on NOTAMs, you can either select them 
from the bar at the top of the screen, or from the sidebar on the left hand side. The NOTAMs will appear 
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on the map as semi-translucent red circles. If you don’t see them and you have a subscription, then first click 
‘Check for updates’ from the ‘update’ menu at the top of the screen. Please note that the download may take 
a minute or two depending on your internet connection.

When the NOTAMs are turned on, you can filter them by selecting standard criteria from the drop-down 
boxes in the sidebar on the left. 

To get more information about a NOTAM, you can right click on it and select it. Please be aware that there 
may be many NOTAMs overlapping each other or even directly on top of one another. When you bring up 
the next of a NOTAM, you have the option to move to the next or previous NOTAM in the list.

For NOTAMs which you have read, but no longer wish to see, you can click the ‘Mark as read’ button to 
remove them from the map.

You can also check more information about NOTAMs through the NOTAM inbox, accessible from the 
Tools menu

Tip: If you accidentally mark a NOTAM as read that you didn’t intend to, you can retrieve it either by selecting the 
‘Show read NOTAMs’ box in the sidebar, or from the NOTAM inbox, accessible from the ‘subscriptions’ menu.

Tip: A very useful feature for filtering NOTAMs is the date search in the sidebar. You can select the date of your 
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intended flight and even the actual time and see only relevant NOTAMs.

IMPORTANT! NOTAMs change on a minute by minute basis, we recommend checking NOTAMs as close to the time 
when you’ll actually be flying as possible. 

IMPORTANT! The Airbox NOTAM service, just like any third party NOTAM service, does not replace your statutory duty 
to check NOTAMs through the official source in the country in which you will fly.

Weather (requires subscription)

When the weather is turned on (either from the sidebar or by clicking the button at the top of the screen), 
you will see weather icons appear on the map. The icons will indicate the general weather and the direction 
of the wind. You can interrogate each icon for further details by right-clicking on it and selecting more in-
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formation. If you can’t see the weather, then make sure that it has downloaded correctly, by clicking ‘Check 
for updates’ from the ‘Update’ menu.

Tip: If you have weather and runways both turned on, then you can see the direction of wind relative to the runway 
and hence establish which runway is likely to be in use and whether there’s a crosswind component.

Flight Guide and Approach Plates (require subscription)

Where installed and available, Flight Guide pages and approach plates can be brought up in Fastplan. To 
access them, right-click with the mouse on an airfield and select the appropriate plate from the approach 
plates menu. You can print approach plates for airfields on your route, from the Route Briefing page.

Subscriptions
Airbox allow you to subscribe to many feeds. Some will be free (such as software updates), some we charge 
for (such as NOTAMs and charts). But you can subscribe to a feed for more or less any information that 
changes over time. The advantage of subscribing to a feed such as charts, is that you know that when they 
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change, you will immediately have the latest version. You can see more information about the options avail-
able on our website at www.airboxaero.com

To view feeds that you are subscribed to, click on the ‘update’ menu on the main map page and select ‘sub-
scriptions’ from the list. If your subscription has not downloaded automatically, you can check it it’s avail-
able by pressing ‘Check for Updates’ from the ‘Update’ menu.
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6 Other Pre-Flight Briefing

Route Briefing (Plogs)

Route briefing can be selected from one of the tabs at the top of the screen. As many fields as possible will 
be automatically filled by Fastplan (depending on your subscription level). Additional fields can be selected 
and filled in by clicking on them and typing. You can save specific plogs for recall later from the file menu 
at the top of the screen. 
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Tip: Information in the plog, such as time en-route, will be partly based on your aircraft parameters. Fastplan allows 
you to set up aircraft in the options menu, so that you can have multiple aircraft ready to go.

Approach plates and flight guide plates can be printed as part of the briefing pack, by selecting them from 
the ‘approach plates’ button on the Route Briefing page. Please note that you will only be allowed to print 
off pages relevant to your route, as this forms part of the basis of Airbox’ contract with the approach plate 
and flight guide providers.

Route briefings can be printed using the print button at the top of the page on the Route Briefing page.
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Weight and balance

Weight and balance can be automatically calculated for your aircraft from the ‘Weight and Balance’ tab. You 
can set your baggage and reserve fuel etc from this page. 

IMPORTANT! Weight and balance calculations given here are based on information entered by you in the aircraft 
setup page (accessible from the Tools menu). It will and can only be as accurate as the information which you enter. 
Attempting to fly with an aircraft out of limits can be extremely dangerous. You must double-check any information 
that the weight and balance calculator gives.
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7 Other Features

Flight Logs

Airbox automatically keeps a log of your flights, you can access these through the sidebar on the left of the 
screen. If you tick the box next to the flight log, it will be overlaid onto the map. You can also view, edit the 
names and export flight logs as GPX files by right clicking on the log entry.
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Custom / User Defined Waypoints

You may wish to put in custom airstrips, helisites or turning points. This can be done simply within the 
software. To create such a waypoint, right-click roughly where you want the point to be created. Now select 
‘Create user-defined waypont’. The system will then offer you a dialogue box with the co-ordinates of the 
point where you clicked. You can now adjust the exact co-ordinates if you wish and also give a name, fre-
quency and altitude to the point. Once done, you will be able to navigate to this point through the standard 
‘plan route’ screen of the software.

Loading and Saving Routes
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You can save a route onto your computer for loading later. To do this, select ‘Save Route’ from the ‘File’ 
menu or click the ‘save’ icon at the top of the map screen. If it’s a route that you do often, you can mark it as 
a favourite so that you can find it more easily later. 

Loading a route is equally simple, you select ‘Load Route’ from the file menu or click the ‘Load Route’ 
button at the top of the map screen. You can shorten the list to show only favourite routes by clicking the 
‘favourites’ icon.

Tip: You can export and import routes to and from Airbox using the GPX format, which is a commonly used route 
format compatible with a wide variety of devices. You can do the using the options from the File menu.

Checking Chart And Airspace Versions
It is very important to be sure that you are using the latest charts to plan your route. You can check the 
chart versions on the map screen, by looking at the chart name at the very bottom of the screen, as you 
move your mouse over the map.

You can check the airspace and airfield information dates on the disclaimer screen when you load the soft-
ware. 

IMPORTANT! It is absolutely your responsibility to ensure that you are using the latest airspace and chart versions on 
the system.

Printing sections of the chart
You can print off sections of the chart (in accordance with the license agreements held between Airbox and 
the chart suppliers).  When you press the ‘print’ button at the top of the chart screen, it will send to your 
printer exactly what you can see on the screen. You therefore should zoom to the most appropriate level for 
your route before pressing the button.

Tip: Depending on your screen, you may find you get a bigger printout by selecting to print in Landscape rather 
than Portrait mode. You can do change the orientation by pressing the ‘Preferences’ button from the print dialogue 
screen.
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Filing VFR and IFR flight plans direct from Fastplan

Fastplan allows filing of flight plans straight from the software. To do so, you will need an account with 
RocketRoute (see www.rocketroute.com for details of how to sign up). The details of this account should 
be entered into the setup menu of Fastplan (accessible through the Tools menu). Once your route has been 
successfully input to Fastplan, you simply press the Rocket button in the toolbar, or select ‘File Flight Plan’ 
from the Tools menu. Your details will then automatically be entered into RocketRoute and your flight plan 
can be immediately filed.
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8 Data and Chart Licensing Agreements

CAA INTERNATIONAL LTD

DATA LICENCE AGREEMENT

1. Licence. CAA International Ltd (“the Owners”) hereby grant you (either an individual or entity) a non-
exclusive, non transferable licence to use the data loaded on the CD-ROM (“the Data”) in accordance with 
the terms of this (“Licence Agreement”). You may not copy, modify, alter, electronically transfer, decompile 
or reverse engineer the Data in any way, other than to make one copy of the Data for back-up purposes. It is 
also your responsibility to ensure that, before loading the Data, you have made adequate back-ups of the ap-
plication software and data stored on your computer. In opening the sealed CD-ROM, you will be deemed 
to have accepted the terms of this Licence Agreement.

2. Restrictions. This licence is personal to you and you may not assign, transfer or sub-licence the Data to 
any other person without the express written consent of the Owners. You may only use the Data on one 
single computer and one single PDA (Pocket PC or other Win CE device) that you own or use. Once you 
have installed the Data on your computer or PDA, you may use the Data on a different computer or PDA 
only if you first delete the Data installed on the first computer or PDA. Printouts of the charts are limited 
to ‘screen-dumps’ and may be taken for your own use including for use in educational and personal research 
documents and projects. Copyright in this material irrespective of its form of presentation will however vest 
in the Owners. Printouts may not however under any circumstances be taken and included in documents 
or publications either in print, photocopy or electronic form to be circulated for republication, promotional 
purposes or sale.

3. Limitations of Remedies. The Owners exclude all liability, (whether in contract, tort or otherwise) arising 
from the use or interpretation of the Data. The Owners liability for any direct loss arising from any defect 
in the CD-ROM or the Data is limited to your purchase price. Except as set out in this Licence Agree-
ment, in no event will either the Owners or their group companies, licensors, suppliers or agents be liable to 
you for any loss or damage of any kind (except personal injury or death resulting from the Owners’ negli-
gence), including any loss of profits, loss of anticipated savings or other indirect or consequential damages 
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arising out of your use or inability to use the Data or from errors or deficiencies in it, whether caused by 
negligence or otherwise.

4. Law. This Licence Agreement is governed by English law and the jurisdiction of the English courts.

The Data includes mapping data licenced from Ordnance Survey with the permission of the Controller of 
Her Majesty’s Stationery Office. (c) Crown Copyright 2001. All rights reserved.

Data included in the product reproduced under licence from CAA International Ltd © Copyright 2008 
CAA International Ltd. All rights reserved.
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Useful Contact and Company Information

Our office is open during normal business hours from Monday to Friday.

The office will be closed on most public holidays and between Christmas and the New Year.

Main Switchboard: +44 (0)1235 227 360

E-mail contacts:

Technical queries Technical@Airboxaero.com

Sales enquiries: Sales@Airboxaero.com

Marketing enquiries: Marketing@Airboxaero.com

Airbox aerospace is a UK company, registration number 06534784

Registered office: Harvard House, Downsview Road, Wantage, Oxon, OX12 9FF, United Kingdom



airbox aerospace ltd, wantage, oxon, ox12 9ff, uk  ¤ +44 (0)1235 227 250 ¤ www.airbox.aero


